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ModusToolbox™ tools package version 3.1.0

About this document

Scope and purpose

ModusToolbox™ software is a set of tools that enable you to integrate our devices into your existing
development methodology. One of the tools is a multi-platform, Eclipse-based Integrated Development
Environment (IDE) that supports application configuration and development.

This document provides information about creating applications as well as building, programming, and
debugging them using the Eclipse IDE.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus

Italics Denotes file names and paths

Courier New Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,
directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Reference documents

Refer to the following documents for more information as needed:

e ModusToolbox™ tools package installation guide

e ModusToolbox™ tools package user guide

e Eclipse survival guide
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1 Getting started

This section provides a basic walkthrough for how to create a couple applications using the IDE, selecting a
BSP. It also covers how to build and program them using the IDE and basic launch configurations supplied for
the applications.

e lLaunch Eclipse IDE

e Open Project Creator tool

e Create an application

e Build application

e Program application

e Export/share application

e |mport application

e Search online for code examples

e Search online for libraries/BSPs

e Access training material

1.1 Launch Eclipse IDE

The Eclipse IDE is installed in the following directory, by default:

<install_path>\ModusToolbox\ide_<version>\eclipse\

Note: If the software is not installed in the default location, you will need to set an environment variable.
Refer to the ModusToolbox™ tools package installation guide for details.

To launch the Eclipse IDE:

e On Windows, select the Eclipse IDE for ModusToolbox™ <version> item from the Start menu.
e Forother operating systems, run the "modustoolbox" executable file.

e Youcanalso launch Eclipse IDE from the dashboard for all operating systems. For more information refer
to the dashboard user guide.

When launching the Eclipse IDE, it provides an option to select the workspace location on your machine. This
location is used by the IDE for creating and storing the files as part of application creation for a particular
platform. The default workspace location is a folder called "mtw" in your home directory. You may add
additional folders under the "mtw" folder or to choose any other location for each workspace.

For more details about Eclipse, refer to the Eclipse documentation, as well as the Eclipse survival guide.
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1.2 Open Project Creator tool

Click the New Application link in the Eclipse IDE Quick Panel.

g Qu.. )=Va. &7 Ex.. ©gBr.

Eclipse IDE for
ModusToolbox™

I E Mew Application I
E Import Existing Application In-Place

& Search Online for Code Examples
& Search Online for Libraries and BSPs
& Training Material

@, Refresh Quick Panel

b Project
b Launches
» Tools

» BSP Configurators

=

O

You can also select File > New > ModusToolbox™ Application.

File Edit Mavigate 5earch Project
New
Open File...

4 Open Projects from File System...

Recent Files

Run

hw - Hello_World/README.md - Eclipse IDE for ModusToolbox™
Window Help
Alt+Shift+N > ™ Project...

=i Other..

s e ModusToolbox™ Application  Ctr+7

Ctrl+M

Infineon

These commands launch the Project Creator tool, which provides several applications for use with different
development kits. The kits available may change over time.

[5] Choose Board Support Package (BSP) - Project Creator 2.10
Settings Help

Source Template

Enter filter text

Create from MPN...| Browse for BSP.

B CY8CKIT-062-WIFI-BT

Kit Name MCU/SOC/SIP
PSoC™ 4 BSPs

v PSoC™ 6 BSPs
CYBCEVAL-06252 CYBC624ABZI-52D44
CYBCEVAL-06252-LAI-43439M2  CY8C624ABZI-52D44
CYBCEVAL-06252-LAI-4373M2  CY8C624ABZI-52D44
CYBCEVAL-06252-MUR-43439M2 CY8C624ABZI-52D44
CYBCEVAL-06252-MUR-4373EM2 CY8C624ABZI-52D44
CYBCEVAL-06252-MUR-4373M2  CY8C624ABZI-52D44
CY8CKIT-062-BLE CYBC6347BZI-BLD53
CY8CKIT-06252-43012 CYBC624ABZI-52D44
CY8CKIT-06254 CYBC6244LQI-54D92
CY8CKIT-062-WIFI-BT CY8C6247BZI-D54
CY8CKIT-064B0S2-4343W CYBO644ABZI-52D44
CY8CKIT-0645052-4343W CYS0644ABZI-52D44
CY8CPROTO-062-4343W CYBC624ABZI-52D44
CY8CPROTO-06252-43439 CYBC624ABZI-52D44
CY8CPROTO-06253-4343W CY8CH245LQ1-53D"

Connectivity

<none>
Sterling-LWB+ (CYW43439KUBG)
Sterling-LWB5+ (CYW4373EUBGT)
LBEESKLTYN (CYW43439KUBG)
LBEESPK2AE (CYW4373EUBGT)
LBEESPK2BC (CYW4373IUBGT)
<none>

LBEES9B1LV (CYW43012COWKWBG)
<none>

LBEESKLTDX (CYW4343WKUBG)
LBEESKLTDX (CYW4343WKUBG)
LBEESKLTDX (CYW4343WKUBG)
LBEESKLTDX (CYW4343WKUBG)
LBEESKLTYN (CYW43439KUBG)
LBEESKLTDX (CYW4343WKUBG)

The PSoC™ 6 WiFi-BT Pioneer Kit is a low-cost hardware platform
that enables design and debug of the PSoC™ 62 MCU
(CY8C6247BZ1-D54) and the Murata LBEESKL1DX Module
(CYW4343W WiFi + Bluetooth Combo Chip).

Kit Features:

*BLEVD.0

* Serial memory interface

* PDM-PCM digital microphone interface
* Industry-leading CAPSENSE

* Full-speed USB

* IEEE 802.11a/b/g/n WLAN

Kit Contents:

* CYBCKIT-062-WIFI-BT evaluation board

« TFT display shield with a 2.4" TFT display, light sensor, 6-axis
motion sensor, and digital microphone

* USB cable

0 error(s), 3 warning(s)
Summary:

BSP: CYBCKIT-062-WIFI-BT

Press “Next" to select application

Next > Close

For more details about using this tool, refer to the Project Creator user guide.
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1.3 Create an application

This section provides a walkthrough for creating a ModusToolbox™ application.

1.3.1 Choose board support package

The Project Creator tool displays a list of boards, showing the Kit Name, MCU, and Connectivity Device (if
applicable). As you select each of the kits shown, the description for that kit displays on the right. Depending on
the settings for your system, you may see different categories, including PSoC™ 4, PSoC™ 6, and AIROC™
Bluetooth® BSPs. For this example, select the CYS8CKIT-062-WIFI-BT kit.

Choose Board Support Package (BSP) - Project Creator 2.10 - a X
Settings Help

Source Template

Enter filter text || |create from MPN... [Browse for BSP..| & @ |cvackiT-062-wiFl-8T
Kit Name MCU/sOC/sIP Connectivity || The PSGC™ 6 WiFi-BT Pioneer Kit is a low-cost hardware platform
PSOC™ 4 BSPs that enables design and debug of the PSoC™ 62 MCU

v PSOC™ 6 BSPs (CY8C6247871-DS54) and the Murata LBEESKL1DX Module
CVCEVAL-06252 CYBC624ABZI-S2D44 <none> (CYW4343W WiFi + Bluetooth Combo Chip).
CYBCEVAL-06252-LAI-43439M2  CYBCE24ABZI-S2D44 Sterling-LWB+ (CYWA43439KUBG) it Features:
CYBCEVAL-06252-LAI-4373M2  CYBC624ABZI-S2D44 Sterling-LWBS+ (CYW4373EUBGT)
CYBCEVAL-06252-MUR-43439M2 CYBCE24ABZI-S2D44 LBEESKLTYN (CYW43439KUBG) *BLEVSO
CYBCEVAL-06252-MUR-4373EM2 CYBC624ABZI-S2D44 LBEESPK2AE (CYW4373EUBGT) * Serial memory interface
CYBCEVAL-06252-MUR-4373M2  CY8C624ABZI-52D44 LBEESPK2BC (CYW4373IUBGT) * PDM-PCM digital microphone interface
CVECKIT-062-BLE CYBC63478ZI-BLDS3 <none> * Industry-leading CAPSENSE
CYBCKIT-06252-43012 CYBC624ABZI-S2D44 LBEES9BILV (CYWA3012COWKWEG) :f:é':;;;f&f: o/ WLAN
CYBCKIT-06254 CYBC6244LQ1-54D92 <none>
CYBCKIT-062-WIFI-BT CYBC6247BZI-D54 LBEESKLTDX (CYW4343WKUBG) Kit Contents:
CYBCKIT-064B0S2-4343W CYBOB44ABZI-S2D44 LBEESKLTDX (CYWA4343WKUBG) o CYBCKIT-062-WIFI-ET evaluation board
CYBCKIT-0645052-4343W CYS0644ABZI-S2D44 LBEESKLTDX (CYW4343WKUBG) « TFT display shield with a 24" TFT display, light sensor, 6-axis
CYBCPROTO-062-4343W CYBC624ABZI-S2D44 LBEESKLTDX (CYW4343WKUBG) motion sensor, and digital microphone
CYBCPROTO-06252-43439 CYBC624ABZI-S2D44 LBEESKLTYN (CYW43439KUBG) o USB cable
CYBCPROTO-06253-4343W CYBC6245L01-53D: | BEESKL1DX (CYWA4343WKUBG) v

0 error(s), 3 warning(s) ~
Summary:

BSP: CYBCKIT-062-WIFI-BT

Press "Next" to select application. v

Next > Close

1.3.2 Select application

Click Next > to open the Select Application page. This page lists various applications available for the selected
kit. As you select an application, a description displays on the right. You can select multiple applications for the
selected BSP by enabling the check box next to the applicable applications.

Select Application - Project Creator 2.10 - ] X
Settings Help
Application(s) Root Path: [C/Users/VegaO/mtw-3.1 Browse...
Target IDE: Eclipse IDE for ModusToolbox™
Enter filter text. 7 | Browse for Application.. ¥ = 7= =] [+ |This code example demonstrates simple UART communication by printing a "Hello World" message
= on a terminal and blinks an LED using a Timer resource.
Template Application New Application Name New BSP Name

Bluetooth® For more details, see the README on GitHub.
v Getting Started
[ Dual-CPU Empty PS0C6 App
[ Empty App
Hello World [EMETEE] ] APP.CYSCKIT-062-WIFI-BT
[ Security App
[ Switching Power Modes
Graphics
Machine Learing
Manufacturing
Peripherals
Sensing
Wi-Fi

Summary: @
BSP: CYSCKIT-062-WIFI-BT

Template Application(s): Hello World

Application(s) Root Path: C:/Users/VegaO/mtw-3.1

Press “Create” to create the selected application(s).

< Back Create Close

User guide 5 002-24375 Rev. *L
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For this example:

e Select the check box next to the "Hello World" application.

o If desired, type a name for the application and/or BSP. Do not use spaces.

1.3.3 Create application

Click Create to begin the application creation process.

remote: Enumerating objects: 154, done.
remote: Counting objects: 100% (9/9), done.
remate: Compressing objects: 100% (2/9), done.

e

Infineon

Note: The application creation process performs a git clone operation, and downloads the selected
application from the GitHub website. Depending on the selected application, this process can take

several minutes.

When complete, the Project Creator tool closes automatically if there are no errors or warnings. If there are
warnings only, click close and the application will open in the IDE. In the IDE, a message will display about

importing the project:

File Edit Mavigste Search Project Run Window Help

Imperting Hello_World (1/1) ...

Q ml=

- | o M -E ‘ F| LI O Ri® PO v - - -]
Eyp 2 4D MER BP = O = O §= Outline 53
2 &l v
5 Hello_World There is no active editor

that provides an outline.

If there are errors, project creation will fail.
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After several moments, the application opens with the Hello_World in the Project Explorer, and the README.md
file opens in the file viewer.

[ hw - Hello_World/README.md - Eclipse IDE for MedusToclbox™ - u] b4
File Edit MNavigate Search Project Run Window Help
Huilld |® -/ - &8 2R Si%-0- Q- S/~ {EHE ¥~ e 6
Q |
9P 52 480 H¥R. S P. = O [ READMEmd 32 = 8 SZoui. = O
B Y 3 e B 8
{2 Fielio Woridi HAL: Hello world ™+ bl HAL Hello world
=% mthb_shared h2. Requirements
- ) . h2. Supported toolc]
This code example demonstrates a simple UART communication by printing h2. Supported kits (7
the "Hello world” message on a terminal and blinking an LED using a timer h2. Hardware setup
resource h2. Software setup
) ) i h2. Using the code ¢
View this README on GitHub h2. Provisioning ste
Provide feedback on this code example :i gpmtm"
. Debugging
~ h2, Design and impl
H h3. Resources ani
Req uirements h?. Related resource|
h2, Other resources
+ ModusToolbox&trade: software v3.0 or later (tested with v3.0) ha. Document histol
b Qu. (Ve G Ex. % Br. = O * PSoC™ 6 board support package (BSP) minimum required version:
4.0.0
. " = XMC™ 7200 evaluation kit BSP minimum required version: 1.0.0 v
Ecllpse IDE for * Programming language. C
ModusToolbox™ < >
Markdown Source | Preview < >
« Start -
) Console [#] Problems g Progress 12 [ Memory (@ Terminal % : =0
[ Mew Application . .
No operations to display at this time.
& Import Existing Application In-Place
& Search Online for Code Examples
& Search Online for Libraries and BSPs
& Training Material
&, Refresh Quick Panel
» Project ~
Writable Insert Tz
Note: Many AIROC™ Bluetooth® applications contain multiple projects. For example, the BLE-

20819EVBO2 application contains projects for Bluetooth® Low Energy services such as anc, ans,
bac, bas, beacon, etc.

1.4 Build application

After loading an application, build it to generate the necessary files. Select a project. Then, in the Quick Panel,
click the Build <project> Application link. The following images show the Quick Panel for a typical PSoC™ MCU
application and an AIROC™ Bluetooth® application.

PSoC™ MCU Application AIROC™ Bluetooth® Application
~ Hello_World (APP_CY8CKIT-062-WIFI-BT) ~ Audio_20819EVB02
I A Build Application I A Build Application
¥ Clean Application ¥ Clean Application
« Launches ~ Launches
4F He o_World Debug (KitProg3_MiniProg4) * Audio_20819EVB02 Attach_JLink
© Hello World Program (KitProa2 MiniProa4) *# Audio_20819EVBO2 Attach_KitProg3_MiniProg4
_ a ( g3_| g4) a .
% Generate Launches for Hello_World Audio_20819EVBO2 Program
% Generate Launches for Audio_20819EVB02
» Tools
" v » Tools N
» BSP Confiaurators (APP CY8B8CKIT-062-WIFI-BT)
< > < >

Messages display in the Console, indicating whether the build was successful or not. For more details about
building applications and the various Consoles available, see the Build applications chapter.
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1.5 Program application

There are many more details about programming an application. This section only covers it briefly. For more
detailed information, see the Program and debug chapter.

In the Project Explorer, select the desired project. Then, in the Quick Panel, click the <app-name> Program
(KitProg3_MiniProg4) link for a PSoC™ MCU application, and <app-name> Program for an AIROC™ Bluetooth®

application.

PSoC™ MCU Application AIROC™ Bluetooth® Application
~ Hello_World (APP_CY8CKIT-062-WIFI-BT) - Audio_20819EVB02
@& Build Application % Build Application

# Clean Application 7 Clean Application

e = - Launches
# Audio_20819EVB02 Attach_JLink

4 Audio_20819EVB02 Attach_KitProg3_MiniProg4
% Audio_20819EVBO2 Program

A Generate Launches for Audio_20819EVB02

¥ He o_World Debug (KitProg3_MiniProg4)

IO Hello_World Program (KitProg3_MiniProg4) I

A Generate Launches for Hello_World

» Tools

» BSP Confiaurators (APP CYSCKIT-062-WIFI-BT) sl
£ > >
1.6 Export/share application

There are several ways to share a ModusToolbox™ application. Refer to the ModusToolbox™ tools package user
guide in the "Using applications with third-party tools" chapter for more general details.

Using the Eclipse IDE, you can use the export function to essentially make a copy of your application that you
can share with a colleague. There are several ways to export using Eclipse. The option we recommend is to use
Export > General > Archive File, which creates a ZIP file.

& Export [m] x
Select . |
Export resources to an archive file on the local file system. g 5
Select an export wizard:
|l}-peﬁlterta<t |
~ [ General
I Archive File
(3 File System
[T Preferences
= CfC++
= Install
(= Run/Debug
= Team
@ < Back Einish Cancel

Keep in mind that a typical ModusToolbox™ application includes many libraries that are available on GitHub.
These get regenerated during the make getlibs command. Therefore, you can substantially reduce the size
of your exported application by excluding the libraries. Plus, the exported mtb_shared folder might retain hard-
coded paths that would cause issues after importing the application.

For multi-core applications, the Eclipse IDE export function shows the core project folders along side the main
application folder. These project folders are included in that main application folder, so you should exclude
them from the export process as well.

002-24375 Rev. *L
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On the Export dialog, select only the main application folder(s) to export. You may need to review your
application in Eclipse to determine which folders you should exclude. By default, subproject folders include an
extension after the application name.

ﬁ Export

Archive file

[m]
X

Please enter a destination archive file.

1125 XMCT7200_Multicore_Empty_App I =) cproject ~
T “FPE-proj_cmip =| .gitignore

]S KMC7200_Multicore Empty_App.proj_cm7_0
]S XMC7200_Multicore Empty_App.praj_cm7_1
1S mtb_shared

z

mtbqueryapi

project
| LICENSE
& Makefile v

Filter Types... Select All Deselect All

To archive fil: ~|| Browse..
Options

(® Save in zip format (@ Creste directory structure for files

(O Save in tar format (O Create only selected directories

Compress the contents of the file

[] Resolve and expert linked resources
@ < Back Mext > Einish Cancel

Click Browse... to navigate to the location to save the archive and provide a file name.

Click Finish to generate the archive file.

1.7 Import application

If you have a ModusToolbox™ application that you want to import into the Eclipse IDE, run the make getlibs
command or use the Library Manager Update button on the application before importing it into Eclipse.

Note: If the application is included in a ZIP file, you will need to extract it before running various
commands.

Then, use the Import Existing Application In-Place link on the Quick panel.

Note: This option does not copy or move the application location on disk; it only makes a reference for
Eclipse to the current application location.

EQuic.. “~Vari.. “Exp.. ®Bre..
Eclipse IDE for
ModusToolbox™
~ Start

& New Application

| = Import Existing Application In-Place

% Search Online for Code Examples

® Search Online for Libraries and BSPs
& Training Material

A Refresh Quick Panel

User guide 9 002-24375 Rev. *L
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On the next page, click the Browse... button, navigate to the application directory, and click Select Folder.

[ Import Eclipse IDE for ModusToolbox™ Project O X
Project information.
Enter the directory of the ModusToolbox™ project to be imported.
Project Location: C:\Users\user\examples_lj\ Browse ...
@ Einish Cancel

Click Finish to begin the import process. This will take a few moments, and then the application will display in
the Eclipse IDE Project Explorer.

If the Console displays a message, such as "Error creating Eclipse configurations," open the Library Manager
and click Update. This runs the make getlibs operation to generate the necessary files and libraries.

Note: There are various ways to import examples into Eclipse. If you prefer a different method, make
sure that all of the project files are copied into the workspace directory.

1.8 Search online for code examples

Infineon provides many code examples. These examples allow you to explore the capabilities provided by the
SDK, create applications based on them, examine the source code demonstrated in them, and read their
associated documentation. The Quick Panel provides a link to access online code examples. Click the Search
Online for Code Examples link. This opens a web browser to the GitHub repository to select and download the
appropriate examples.

EQuic.. “Vari.. FExp.. %Bre.. = -
e Code examples for ModusToolbox™ software
Eclipse IDE for

™
ModusToolbox There are hundreds of code examples available. Use the links below to find the example you want, learn more

~ Start about each repo, and discover how to bring that code example into your development environment.

E . - -
New Application For details on how to use a code example, see the Getting Started chapter of the ModusToolbox™ tools

= Import Existing Application In-Place package user guide.

# Search Online for Code Examples

7 - — See the individual Amazon FreeRTOS example repository for details on how to import each code example into
Search Online for Libraries and BSPs

a Amazon FreeRTOS build system respectively. Typically, you'll find the precise command line in the readme file.
Training Material

& Refresh Quick Panel Repo Description
PSoC™ 6 MCU This search link displays all PSoC™ 6 MCU examples for ModusToolbox™ software.
examples These examples demonstrate the MCU and its features and functionality.
PSoC™ 4 MCU This search link displays all PSoC™ 4 MCU examples for ModusToolbox™ software.
examples These examples demonstrate the MCU and its features and functionality.

This search link displays all XMC MCU examples for ModusToolbox™ software.
XMC MCU examples . L
These examples demonstrate the MCU and its features and functionality.

PMG1 MCU This search link displays all PMG1 MCU examples for ModusToolbox™ software.
examples These examples demonstrate the MCU and its features and functionality.
User guide 10 002-24375 Rev. *L

2023-05-16



Eclipse IDE for ModusToolbox™ user guide

Getting started

1.9 Search online for libraries/BSPs

Infineon also provides all the libraries and BSPs online at GitHub. The Quick Panel provides a link to access

these. Click the Search Online for Libraries and BSPs link. This opens a web browser to the GitHub repository

that shows the ModusToolbox™ software page.

& Quic... *-Vari.. % Exp.. ® Bre.

Eclipse IDE for
ModusToolbox™

~ Start

& New Application

= Import Existing Application In-Place
@ Search Online for Code Examples

# Search Online for Libraries and BSPs

€ Training Material
& Refresh Quick Panel

= g

1.10

Infineon

ModusToolbox™ software

ModusToolbox™ software is a modern, extensible development environment supporting a wide range of Infineon
micracontroller devices. It provides a flexible set of tools and a diverse, high-quality collection of application-focused
software. These include configuration tools, low-level drivers, libraries, and operating system support, most of which
are compatible with Linux, macQS, and Windows-hosted environments.

This page helps you identify and find the ModusToolbox™ resources available. These resources are grouped in the
following top-level categories:

* Tools
* Code examples (link to separate page)
* Board support packages

* Libraries
Tools

The ModusToolbox™ tools package installer (https://www.cypress.com/products/modustoalbox-software-
environment) provides various multi-platform development tools to help you work in your preferred flow. The installer
includes a make-based build system, Eclipse IDE, configurators, stand-alone project creator and library manager, as
well as support for using other IDEs, generating code, compiling, pregramming, and debugging. Refer to the
ModusToolbox™ user guide for complete details.

Access training material

Infineon also provides training material at GitHub. The Quick Panel provides a link to access these. Click the
Training Material link. This opens a web browser to the GitHub repository that shows the ModusToolbox™

training page.

& Quic.. ¥-Vari.. * Exp.. s Bre..

Eclipse IDE for
ModusToolbox™

~ Start

= New Application

= Import Existing Application In-Place
@ Search Online for Code Examples

% Search Online for Libraries and BSPs

& Training Material

A Refresh Quick Panel

= O

User guide

ModusToolbox™ Software Training

This page contains links to ModusToolbox™ training classes that are available on GitHub. These classes are organized
in a modular fashion and broken into levels. Each class is focused on a specific area so that you can learn about a topic
quicker and build upon your knowledge as your needs evolve.

The level 1 getting started class covers the basic concepts and building blocks of ModusToolbox™. Level 2 classes
cover a product or product family such as PSoC™. Level 3 classes cover more advanced systems such as Bluetooth®,
Wi-Fi, or Machine Learning.

ModusToolbox™ Software Training Level 1 - Getting Started

s This is the entry-level ModusToolbox™ training class. It is a pre-requisite for all level 2 and level 3 ModusToolbox™
training classes.

& This class is a survey of the ModusToolbox™ development platform. The learning objective is to introduce you to
all the tools in the ModusToolbox™ ecosystem and help you develop some familiarity with using them. The class is
“a mile wide and an inch deep.” This should enable you to understand the scope of the development ecosystem
and teach you where to find “everything.”
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2 IDE description

The IDE is based on the Eclipse IDE. It uses several plugins, including the Eclipse C/C++ Development Tools
(CDT) plugin. For more information about Eclipse, refer to the Eclipse Workbench User Guide. We also provide a
document called the Eclipse IDE survival guide, which provides tips and hints for how to use the Eclipse IDE.

The IDE contains Eclipse standard menus and toolbars, plus various panes such as the Project Explorer, Code
Editor, and Console. One difference from the standard Eclipse IDE is the "ModusToolbox™ Perspective." This
perspective provides the "Quick Panel," and adds tabs to the Project Explorer. "Perspective" is an Eclipse term
for the initial set and layout of views in the IDE.

[ hw - Hello_World/README.md - Eclipse IDE for ModusToolbox™ - u] X
Eile Edit Navigate Search Project Run Window Help Menus &
Al | ®-RrRmiE! 4 SR EiH-0-%~®™ 5 Toolb R
oolbars Q im|E
EyP. 22 4D M¥R. ZP. = O [% READMEmd i3 = B8 ZEoui.x = 08
S - =l
rid: HAL: Hello world " hl. HAL Hello world
5 mib_shared h2. Requirements
h2. Supported toolc]
This code example demonstrates a simple UART communication by printing ha. s:z;zrt:d ;:S ;
Project the "Hello world” message on a terminal and blinking an LED using a timer h2. Hardware setup
resource. h2. Software setup
h2. Using the cod
Explorer View this README on GitHub o P ]
Provide feedback on this code example. :; gpmtm"
. Debugging
~ h2. Design and impl
H h3. Resources ani
Req UIrements h2. Related rescurce|
COde Ed ItOF h2. Other rasour.cas
+ ModusToolbo later (tested with v3.0) h2. Document histol
. =Va. ffEx. %Br. = O » PSoC™ 6 boarosupporpackage To=P) minimum required version:
400
. ~ = XMC™ 7200 evaluation kit BSP minimum required version: 1.0.0 v
ECl'Pse IDE for » Programming language C
ModusToolbox™ < >
Markdown Seurce | Preview < >
v Start & Console [£l! Problems &3 Progress 52 [] Memory { Terminal % 8§ = O
Q New Application
Ne cperations to display at this time.
¥ e
4 Quick Panel
4 Console
& Training Material
&, Refresh Quick Panel
» Project v
0 items selected
Note: If you switch to a different perspective, you can restore the ModusToolbox™ Perspective by clicking

the ModusToolbox™ icon button in the upper-right corner. You can also select Perspective > Open
Perspective from the Window menu. To restore the ModusToolbox™ Perspective to the original
layout, select Perspective > Reset Perspective from the Window menu.

The following describe different parts of the IDE:

e Menus and toolbars - Use the various menus and toolbars to access build/program/debug commands for
your application. Many of these are covered in the Eclipse Workbench User Guide.

e Project Explorer - Use the Project Explorer to find and open files in your application. See Project Explorer
for more information.

e Quick Panel - Use this tab to access appropriate commands, based on what you select in the Project
Explorer.

e Code Editor - Use the Code Editor to edit various source files in your application.

e Console - Use these tools to review messages and access the integrated terminal.
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2.1 Project Explorer

In the Eclipse IDE, after creating an application, the Project Explorer contains one or more related project
folders. The following images show a PSoC™ MCU application and an AIROC™ Bluetooth® application.

PSoC™ MCU Application AIROC™ Bluetooth® Application
[£5 Project Explorer 2 %% Debug ¥!f Registers %, Peripherals % [&5 Project Explorer ¢ 47 Debug Ui Registers 7 Peripherals = 0O
CRA EST
5 Audio_Handsfree § README_‘md 4
« &5 Hello_World + 1= LE_Hello_Client
§ ! Includes
&) Includes & build
&= bsps (= COMPONENT _btstack_v1
= build (= COMPONENT _btstack v3
= deps = deps
(= images & libs
& libs [& hello_client.c
& main.c B hello_cllrenth
~ [# hello_uuid.h
= LICENSE El LICENSE.txt
L& Makefile L& makefile
README.md E makefile.nit
5 LE_Hello_Client [¥ READMEmd
=% mtb_shared [Zl version.xml
128 mth charad, b

Both types of applications contain a similar project structure. Each contains the main application source code,
and a Makefile. Note that PSoC™ MCU applications contain a libs directory, while AIROC™ Bluetooth®
applications have a wiced_btsdk project with shared SDK, BSPs, and libraries for all applicationsin a
workspace.

2.2 Quick Panel

As stated previously, the Quick Panel is part of the "ModusToolbox™ Perspective." It provides quick access to
commands and documentation based on what you have selected in the Project Explorer.

PSoC™ MCU Application AIROC™ Bluetooth® Application
= Quick Pa.. - Variables % Expressi.. % Breakpo.. = & Quic.. = Varia.. S Expr. %gBrea. = O
i et : Elpe 1 o
ModusToolbox™
~ Stard
e ~ Start

&= New Application
Mew Application

ﬁ Import Existing Application In-Place
& Search Online for Code Examples
& Search Online for Libraries and BSPs
& Training Material

& Refresh Quick Panel

= Import Existing Application In-Place

& Search Online for Code Examples

& Search Online for Libraries and BSPs

&£ Training Material

& Refresh Quick Panel

~ Hello World (APP_CY8CKIT-062-WIFI-BT)
~ LE_Hello_Client (CYW920819EVB-02)
% Build Application
&, Build Application

# Clean Application aa ol
ean Application

~ Launches
= Launches
¥ Hello_World Debug (KitProg3_MiniProg4)

© Hello_World Program (KitProg3_MiniProg4)

% Generate Launches for Hello_World

A5 LE_Hello_Client Attach_JLink
35 LE_Helle_Client Attach_KitPreg2 MiniProgd
@, LE_Hello_Client Program

~ Tools @ Generate Launches for LE_Hello_Client

&8 BSP Assistant 1.10
~ Tools
& Device Firmware Update Host Tool 2.0

& Library Manager 2.10 Library Manager 2.0

N ~ BSP Configurators (CYW920819EVB-02)
~ BSP Configurators (APP_CY8CKIT-062-WIFI-BT)

[ Device Configurator 4.
& CAPSENSE™ Configurator 6.10 I Device Configuretor

& CAPSENSE™ Tuner 6.10 « LE_Hello_Client Library Configurators
& Device Configurator 4.10 m Bluetooth® Cenfigurator 2.60 (new configurator)
& Qsp Configurator 410 ~ LE_Hello_Client APl Documentation

s tLCD Configurator 1.51 (new configurats
o cgmen onfigurator (new configuration) v [5] AIROC™ Blugtooth® SDK Documentation

< >
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The Quick Panel contains links to various commands and documentation, organized as follows:

e Start - This contains the New Application link to create new applications, and links to find Code Examples,
Libraries, BSPs, and training material.

o Selected <app-name> project - This contains different project-related links based on the project that is
selected in the Project Explorer, as well as the type of application. Links here include: Build and Clean the
application.

e Launches - This contains various Launch Configurations, based on the selected application project and
device, which can be used to program the device and launch the debugger. This area is only populated if
you have the top project in your application selected (<app-name>). For more information, see Launch
configurations.

e Tools - This contains links to the various tools available for the selected project. For more information, see
Use configurators and Use tools.

e Documentation - This may contain several documents in HTML format, which are included as part of the
chosen BSP.
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3 Configure applications
This chapter covers how to make various changes to your application. It includes:

¢ Modify code

e Use configurators

e Usetools
e Useintegrated terminal

e Refresh Quick Panel

e Rename single-core application

e Restore shared directory

3.1 Modify code

Most code examples work as they are, and there is no need to add or modify code in order to build or program
them. However, if you want to update and change an application to do something else, or if you are developing
your own application, open the appropriate file in the code editor.

e PSoC™ MCU: In the Project Explorer, double-click the main.c file.

KPro.. ® #De.. WiRe. #Peri. ~ 7 BFREADMEmd [ mainc = -
ES YV § * including Cypress's product in a High Risk Product, the manufacturer ~
~ £ Hello_World * of such system or application assumes all risk of such use and in doing
& Includes * so agrees to indemnify Cypress against all liability.
*******************************************************************************/
& build
& deps 2 #include "cy pdl.h"
= images 2 #include "cyhal.h"
= libs #include "cybsp.h"
2 #include "cy retarget io.h"
= LICENSE
oMakeﬁle 7/*******************************************************************************
= makefile.init * Macros
README d *******************************************************************************/
L] .m

Note: The "includes" in this example show "unresolved inclusions" because the files are located in the

mtb_shared folder. This and other issues with IntelliSense are resolved after a build.

o AIROC™ Bluetooth®: In the Project Explorer, expand the <app-name> project folder and double-click the
application <app-name=>.cfile.

[f5 Proj.. 32 45 Deb... [£] hello_sensor.c 3 = O

Wil Regi... Z, Peri. = O
8BS 7 3
~

hello _sensor_state t;
v'l_,-§ LE_Hello_Sensor } - - -

= deps

(= libs
E hello_sensor.c
TR ReNo_sensor.

B oo -
%#, Binaries #pragma pack(1)

s Includes /* Host information sawved in NVRAM */
== build = typedef PACKED struct

= COMPOMENT_CYW320721B2EVK-03_design_m

BD_ADDR  bdaddr;
uintlé_t characteristic_client_cenfiguration;
uintd_t  number_of_blinks;

} hest_info_t;

#pragma pack()

/* BD address of
Current value
/* Sensor config

ET wiced_bt_cfg.c

= LICENSE.txt = typedef struct

makefile uintls_t handle;

= makefile.init uintle_t attr_len;

[w| README.md v void *p_attr;
< > } attribute_t;

As you type into the file, an asterisk (*) will appear in the file’s tab to indicate changes were made. The
Save/Save As commands will also become available to select.
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3.2 Use configurators

ModusToolbox™ software provides graphical applications called configurators that make it easier to configure
a hardware block. However, before you make changes to settings in configurators, you should first copy the
configuration information to the application and override the BSP configuration or create a custom BSP. If you
make changes to a standard BSP library, it will cause the repo to become dirty. Additionally, if the BSP is in the
shared asset repository, changes will impact all applications that use the shared BSP. For more information,
refer to the ModusToolbox™ tools package user guide.

Each configurator provides a separate guide, available from the configurator's Help menu.

3.2.1 Launching configurators from the IDE

To launch a configurator from the Eclipse IDE, right-click on the <app-name> project in the Project Explorer,
select ModusToolbox™, and then select the appropriate configurator.

NEW
%5 Project Explore N .
=% Hello_Worlc Open in New Window
& mtb_shared  Show In Alt+Shift+W >
= ModusToolbox™ > BSP Assistant 1.0
Show in Local Terminal ? CAPSENSE™ Configurator 5.0
2 Copy Ctrl+C CAPSENSE™ Tuner 5.0
Paste Ctrl+V Device Configurator 4.0
% Delete Delete Device Firmware Update Host Tool 1.60
Source 4 Library Manager 2.0
Move.. Project Creator 2.0
Rename... 2 QSPI Configurator 4.0
1 Import.. Smart /O Configurator 4.0
i Export.. Segment LCD Configurator 1.50 (new configurator)
Build Project Bluetooth® Configurator 2.60 (new configurator)
& Quick Panel ¢ Clean Project USB Configurator 2.50 (new configurator)
Note: You can also launch available configurators from links in the Quick Panel.

Depending on the enabled resources in your application, there may be several configurators available to
launch.

e Ifyou launch the Device Configurator from the IDE, you are opening the project’s design.modus file, which is
responsible for holding all of the BSP configuration information. It contains the following:
e Selected device
e Resource parameters
e Constraints

e Ifyou launch any of the other configurators from the IDE, they will open using that configurator’s
configuration file (design.cycapsense, design.cyseglcd, etc.). These files are specific to the given resource,
and they may rely on configuration data from the design.modus file.

3.2.2 Launching configurators without the IDE

To launch any Configurator without using the IDE, refer to the applicable configurator guide for details about
configuration information. You may need to open a configuration file or create a new one.
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3.3 Use tools

In addition to the configurators, there are several tools, including Library Manager, BTSpy, ClientControl, and
Device Firmware Update (DFU) Host Tool. Many tools do not apply to all types of projects. So, the available
tools depend on the project/application you have selected in the Project Explorer.

3.3.1 Launching tools from the IDE

To launch a tool from the Eclipse IDE, right-click on the <app-name> project in the Project Explorer, select
ModusToolbox™, and then select the appropriate tool.

Byp 32 4D WER ZP = O

2

w =% Empty_BTSDV Aem =

[l Includes New ?
= build Go Into
~ d
F? |-Ep5 Open in New Window
= libs
[€ app_bt_c Show In Alt+Shift+W >
app_bt_c E ModusToolbox™ ¥ Library Manager 1.40 Ctrl+8
% empty_w Show in Local Terminal > BTSpy
cycfg_bt. ;
= LICENSE: [2 Copy Ctrl+C Blluetooth Configurator 2,50
makefile Paste CtrlsV ClientControl
= makefile, 3¢ Delete Delete Device Configurator 3.10
Note: You can also launch available tools from links in the Quick Panel.
3.3.2 Library Manager

The Library Manager allows you to select which Board Support Package (BSP) and version should be used by
default when building a ModusToolbox™ application. It also allows you to add and remove libraries, as well as
change their versions.

For more information about how to use this tool, refer to the Library Manager user guide.

3.3.3 BTSpy and ClientControl

BTSpy is a trace utility that can be used in the AIROC™ Bluetooth® applications to view protocol and generic
trace messages from the embedded device. The tool listens on the UDP port 9876 and can receive specially
formatted message from another application on the same or different system.

BTSpy can be used in conjunction with ClientControl to receive, decode and display protocol application and
stack trace messages. ClientControl communicates with the embedded app to perform various functionalities,
tests, exercising features, etc.

3.3.4 DFU Host tool

The Device Firmware Update (DFU) Host tool is a stand-alone program used to communicate with a PSoC™
MCU that has already been programmed with an application that includes device firmware update capability.
For more information, refer to the Device Firmware Update Host tool user guide.
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3.4 Use integrated terminal

The Eclipse IDE for ModusToolbox™ software includes an integrated terminal where you can enter various
commands for the selected project. To view the terminal, click the Terminal tab in the bottom pane. Then,
select a project in the Project Explorer to open a shell in the project directory.

E mtw-3.1-example - Hello_World/README.md - Eclipse IDE for ModusToolbox™ 3.1 - ] X
File Edit Navigate Search Project Run Window Help
e (B ~R~Bit~-O~G~i®y~D ; |= =] v §l - o~ Q x|
5 Proje.. 2 % Debug ¥ Regis.. % Perip.. ~ o [¥| READMEmd =0 x =0
~ HAL: Hello world A otk
= mtb_shared h2. {
h2.
This code example demonstrates a simple UART communication by h2.d
printing the "Hello world" message on a terminal and blinking an LED h2.
using a timer resource. The code example is based on HAL(Hardware h2.d
Abstraction Layer) libraries. h2.
h2.§
View this README on GitHub. ha.
h2.
& Quick.. =Variab.. % Expre.. % Break. ~ 5  Provide feedback on this code example. o2
h
Eclipse IDE for ~ R i h2. §
equirements ‘
ModusToolbox™ q n2.
h2.
» Start
+ ModusToolbox&trade; software v3.0 or later (tested with v3.0)
» Hello_World (APP_CY8CKIT-062-WIFI-BT) - Programming language: C
» Launches + Associated parts: All PSoCé&trade; 6 MCU parts, XMC7000 MCU
» Tools + PSoC™ Ei{t‘)?‘ard \s{tlffp‘)grl;tne‘ackalge ‘(_BSIID_)‘ Tiﬂn'i_’mu_m_required L
» BSP Configurators (APP_CYBCKIT-062-WIFI-BT) < >
Markdown Source Preview <
~ Hello_World Library Configurators = . e
& Bluetooth® Configurator 2.80 (new configuration B Console (2! Problems =g Progress 0 Memory 9 Terminal 2 5 @ ot | Im Gu BH| 5 =
& Hello_World ModusShell &2
& LIN Conf gurator 1.21 (new configuration)
~ Hello World APl Documentation 150620977Y4
5] Retarget IO (retarget-io) o
< . >
Note: You can configure the terminal colors for the Workspace under Window > Preferences >Terminal.
3.4.1 Switch projects

When you switch projects, the Eclipse IDE creates additional tabs and automatically switches between them, so
that a shellin the current project directory is always in focus. To disable this automatic switching, deselect the
Track Current Project button in the terminal toolbar.

B Console [#] Problems [ Memory 8 Terminal 32 2 .;:f| i ® of .},,‘ﬁ = 8
& Helle_Werld ModusShell 2 AnyCloud_BLE_CapSense_Buttons_and_Slider ModusShell &2

ns_and_Slider
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3.4.2

Specify alternate shell

By default, the terminal uses your login shell on Linux and macOS, or the "modus-shell" Cygwin bash shell
provided with your ModusToolbox™ tools installation on Windows. You can specify a different shell from
Window > Preferences > ModusToolbox™ Tools.

E Preferences

| type filter text

| | ModusToolbox™ Tools

General
C/C++
Context

Help
Install/Update
MCU

Run/Debug
Team
Terminal

g
=T g -~ 8
8

*

| Shell for terminal view | |

Browse... |

Argurnents to shell | --login -i

MeodusToolbox™ Tools

Remote Development

Restore Defaults

Apply and Close

Apply

Cancel

3.4.3

Update local terminal settings

By default, the local terminal uses your User home directory as the Initial Working Directory. You can specify
different options from Window > Preferences > Local Terminal.

ModusToolbox™ Taols
Remote Development
Run/Debug

selection of the active view.

"Show In ..." Custom Entries

Note:

User guide

ModusToolbox™ Tool:
» Remote Development
» Run/Debug

Note: Leave the shell command empty to fallback to the SHELL environment variable or if
not set, to /bin/sh.

Initial Working Directory

Name Path Add... » Team User home - Browse. Variables.
Team
« Terminal Git Bash Ci\Users\follettcj\AppData\Local\P... Edit | > Terminal Note: The chosen initial working directory might be overwritten by the current selection of
S | Local Terminal the active view.
Local Terminal =
R, Show In..." Custom Entries
Add.
Restore Defaults Apply |
Restore Defaults Apply
Y
@ g 4 Apply and Close Famen
?

Cancel

Apply and Close

Linux and macOS include additional settings for Shell Command and Arguments.
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3.44 Connect to remote machine/board

You can also connect to a remote machine or board via serial, telnet, or SSH by clicking the Open a Terminal
button in the terminal toolbar.

B Console [Z Problems [J Memory @ Terminal i3 S, |$‘~f | i ® of & =8
& Hello_World ModusShell 2 AnyCloud_BLE_CapSense_Buttons_and_Slider ModusShell 23

oud_BLE_CapSense_Buttons_and_Slider

Q Launch Terminal

Choose terminal: | (Git Bash

Settings
Encoding: | UTF-8 ~
@

Use the Choose terminal pull-down menu to select the appropriate terminal.

3.5 Refresh Quick Panel

When you use tools external to the Eclipse IDE, such as the Library Manager or Device Configurator, it is likely
that the Eclipse IDE will not refresh to detect changes made in those other tools. Use this link to refresh the
Eclipse IDE. You may notice new documentation links or a new Active BSP in the Quick Panel as an indication
that your application has new libraries and/or components.

=Quic. -Vari. * Expr. %Brea. = U

Eclipse IDE for ~
ModusToolbox™

~ Start

= New Application

= Import Existing Application In-Place

@ Search Online for Code Examples

@ Search Online for Libraries and BSPs

& Training Material

A Refresh Quick Panel
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3.6 Rename application

3.6.1 Single-core application

The Eclipse IDE for ModusToolbox™ software uses the standard Eclipse rename functionality. That is, right-click
on the application and select Rename. If you use the rename feature, you will need to update your
application’s launch configurations. The easiest way to do this is to use the "Generate Launches..." link in the
Quick Panel.

After renaming the application, select it in the Project Explorer and notice that there is only one item under
Launches. Click on the Generate Launches for... link. After a few moments, the generate process completes.
Click on the application again in the Project Explorer and notice that all the items are shown under Launches in
the Quick Panel.

» Start Start
» Star
* Rename_Application
i » Rename_Application (APP_CY8CKIT-062-WIFI-BT)
~ Launches P—
~ Launches

% Generate Launches for Rename_Application

I Rename_Application Debug (KitProg3_MiniProg4)

» . . e - .
Tools © Rename_Application Program (KitPrag3_MiniProg4)

* BSP Configurators (<bsp-name:) % Generate Launches for Rename_Application

» Hello World Library Configurators » Tools

* Hello World APl Documentation

» BSP Configurators (APP_CY8CKIT-062-WIFI-BT)
» Rename_Application Library Configurators

» Rename_Application APl Documentation

3.6.2 Multi-core application

For a multi-core application, you also use the standard Eclipse rename functionality; however, there are a few
additional steps required. After renaming the main application project, you'll notice that the core subprojects
become regular folders.

[ Project Explorer 5 ES%Y § = 0O
(£S mtb_shared

= proj_cmip
(= proj_cmT 0
(= proj_cm7 1
% common_app.mik

& common.mk
[ LICENSE
& Mskefile
README.md

Select each folder, right-click, and select Import as Project.

[ Project Explore Go Into
s Ez ;"::;:::d Open in New Window
(= bsps Show In Alt+Shift+W >
(= proj_cmi Show in Local Terminal >
S oy Ctec
@ mm_mur Paste Ctrl+V
@ commor 3§ Delete Delete
[ LICENSE Source ¥
@& Makefile Mave..
README
Rename... F2
2 Import as Project [}
Note: During the rename process, you may see index errors. These usually go away once the rename
process is complete.
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After making each folder a subproject, notice that each retains the prefix of the original application name.

[¥5 Project Explorer 53 S Y 8 = 0O
=5 mtb_shared
v =5 Renamed
(= bsps
{25 HMC-7000-Wiult, proj. cmip [
L ’Me-7000-Multhproj_em? |
125 ¥MC-7000-Multi.proj_em7_1 (in

@ common_app.mk
& common.mk

=| LICENSE

& Makefile

[#) README.md

You can rename each subproject individually, but ensure they each have a unique name. You can do so by
keeping the suffix.

| Rename Resource m] ®

New name: | (TSRS proj_cm0p
nces

When complete with the rename process, you may have to build the application or click the Generate
Launches for ... link as described under Single-core application.

3.7 Restore shared directory

Beginning with the ModusToolbox™ 2.2 release, shared BSPs, libraries, and versions are located in a shared
directory (named mtb_shared, by default) adjacent to your application directories. You can delete the
mtb_shared directory at any time because it can be recreated. You might do this when sharing the application,
for example. The shared directory only contains files that are already controlled and versioned, so you should
NOT check it into a revision control system.

When using the Eclipse IDE, if you delete the shared library directory from disk and then regenerate it, the
directory will not be restored properly. This is because several files required by the Eclipse IDE are not restored
as they were when the application was created. To resolve this:

1. Regenerate the mtb_shared directory and assorted libraries on disk using make getlibs orthe Library
Manager.

2. Inthe Eclipse IDE, delete the "mtb_shared" folder shown in the Project Explorer.

Note: Do NOT select the check box "Delete project contents on disk" (if you do, you will have to
regenerate it again).
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3. Then, select File > Import > C/C++ > Existing Code as Makefile Project and click Next >

4,

Select

Select an import wizard:

type filter text

Creates a new Makefile project in a directory containing existing code

243

(= General
v (= C/C++
[E] C/C++ Executable
ﬁ.ﬁj C/C++ Project Settings
Existing Code as Makefile Project
= Git
= Install

Cancel

On the Import Existing Code page:

Import Existing Code

Create a new Makefile project from existing code in that same directory

Project Name
mtb_shared

Existing Code Location

C:\Users\SirrineCaith\mtw3.0\mtb_shared

| Browse... |

Languages

M e+

Toolchain for Indexer Settings

Cross GCC

Show only available toolchains that support this platform

<pnone>
ARM Cross GCC |

Cancel

a. Under Existing Code Location, click Browse..., navigate to the application's root directory, select
the "mtb_shared" folder, and click Select Folder.

b. Under Toolchain for Indexer Settings, select ARM Cross GCC.

c. Click Finish.

5. After the import completes, build the application.
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4 Build applications

This chapter covers various aspects of building applications. Building applications is not specifically required,
because building is performed as part of the programming and debugging process. However, if you are running
the Eclipse IDE without any hardware attached, you may wish to build your application to ensure all the code is
correct. If you changed code in one of your projects, you may wish to build just that project.

e Build with Make
e Build with IDE

e GCCversion

4.1 Build with Make

You can build applications from the command line using Make. Refer to the ModusToolbox™ tools package user
guide (also located in the <install>/ide_<version>/docs directory) for more information. The document is also
available from the IDE's Help menu.

4,2 Build with IDE

After loading an application, it is best to first build everything to generate the necessary files. Click on a project
in the Project Explorer. Then in the Quick Panel, click the "Build <app-name> Application" link.

- Hello World (APP_CYBCKIT-062-WIFI-BT)
A Build Application

¥ Clean Application

~ Launches
3 He o_World Debug (KitProg3_MiniProg4)
O Hello_World Program (KitProg3_MiniProg4)

% Generate Launches for Hel o_World

» Tools

Building an application will typically allow IntelliSense to work better. It may also be useful to right-click on a
project and select Index > Rebuild to allow IntelliSense to find references.

Messages display in the Console, indicating whether the build was successful or not.

& Console &3 @ﬁﬁﬂ B =i iEal“"E'::?':'E'
CDT Build Console [HelloWarld]

[ .data | ©x@gewlisc | 194 I -

| .cy_sharedmem | exesee2azg | 12 |

| .moinit | exeses2a3s | 148 |

| .bss | exese@lacc | 964 |

| .heap | exespe2e08 | 276348 |

| .cy_sflash_user_d | exleeeeses | 8 |

| .ey toc_part2 | exlsea7ced | 512 |

Total Internal Flash (Available) 1848576

Total Internal Flash (Utilized) 44772

Total Internal SRAM (Available) 292864

Total Internal SRAM (Utilized) 279928

B7:27:22 Build Finished. @ errors, @ warnings. (took 43s.348ms)

< >
Note: Be aware that there are several Console views available.
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You can access the different views using the Display Selected Console Q- button (or the pull-down arrow).
The Global Build Console is the only way to see all of the results in one place. If you just have the standard
Console open, it resets every time a new project in the application starts building. You won’t see any errors if
they are not on the final project that gets built.

For subsequent updates, you can build one or more projects using the right-click menu options. Any projects

that are dependent on the project being built will also be built. The Eclipse IDE supports all the usual
application and build options available for the native Eclipse IDE.

Note:

4.3

When the active build configuration is changed it affects only the selected project. The active build
configuration for any dependent projects is specified separately for each project. Therefore, if you
want to use the same configuration for all projects (for example, Debug or Release), it must be set
for each project. It is possible to select multiple projects at once from the Project Explorer and then
select the active configuration.

GCC version

ModusToolbox™ software includes GCC version 10.2 as the preferred toolchain to use with the Eclipse IDE. If
you have a different version of GCC you prefer, update the project properties to point to the appropriate
toolchain folder. Open the project Properties dialog, and click the Toolchains tab, and then click the
appropriate link to update global or workspace preferences, or project properties.

type filter text Settings Aol A
Resource ~
ARM Toolchains Paths seration: |PEETA Po—

- ~
Builders Configuration: Debug [ Active ] Manage Configurations...
¥ C/C++ Build
Build Variables ® Toolchains |B Devices @ Binary Parsers @ Error Parsers
Environment
Logging Name: \ GNU MCU Eclipse ARM Embedded GCC (arm-none-eabi-gcc) -
Setlings Architecture: ARM (AArch32)
Tool Chain Editor Prefi
C/Cr+ General refix: arm-none-eabi-
Project Natures suffix [ ]
Project References C compiler:
Run/Debug Settings C++ compiler:
WikiText
Archiver: ar
Hex/Bin converter: | objcopy
Listing generator: | objdump
Size command
Build command:
Remove command:
Toolchain path: ‘ ${cy_tools_path:CY_TOOL_gcc BASE}/ bin ‘
(to change it use the global or workspace preferences pages or the project properties page)
Build tools path: ‘ ${cy_tools_path:CY_TOOL modus-shell BASE}/bin ‘
(to change it use the global or workspace preferences pages or the project properties page)
Create flash image
[[] Create extended listing
Print size .
®@ Apply and Close Cancel
B *
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5 Program and debug

Programming and debugging are native to your chosen development environment. Infineon devices are
supported in the major program and development solutions. Primarily, this means J-Link and OpenOCD. These
solutions provide for programming flash within a device and provide a GDB server for debugging.

This chapter covers various topics related to building and debugging, including:

e PSoC™MCU programming/debugging

e Launch configurations

e Switch to J-Link programmer/debugger

e Changing programming interface SWD/JTAG

e Using JTAG interface in MiniProg4

e Erasing external memory

e Programming eFuse

e Debug connection options
e Select specific CMSIS-DAP device

e Select specific J-Link device

e KitProg Firmware Loader

e PSoC™4 flash security programming

e AIROC™ Bluetooth® programming/debugging

e Program configuration

e Attach configurations

e Debug settings

5.1 PSoC™ MCU programming/debugging

5.1.1 Launch configurations

The flow for programming and debugging is similar for all devices. The Eclipse IDE contains several Launch
Configurations that control various settings for programming the devices and launching the debugger.
Depending on the kit and type of applications you are using, there are various Launch Configurations available.

There are two sets of configurations: one for KitProg3_MiniProg4 (included on-board on most Infineon PSoC™ 6
and PSoC™ 4 based kits) and another for SEGGER J-Link.

Note: The KitProg3_MiniProg4 launch configuration also supports the MiniProg4, which you attach to
the kit via a 10-pin debug connection. See the MiniProg4 product page for details. The MiniProg3 is
not supported.
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The Launch Configurations are shown in the Run/Debug Configurations dialog, similar to the following.

Q Debug Configurations [m] X
Create, and run figurations @
B &Y~

Configure launch settings from this dialog:

‘ type filter text - Press the ‘New Configuration® butto..a configuration of the selected type.
[c] GDB Hardware Debugging
~ [c] GDB OpenOCD Debugging
[€] Hello_World Attach (KitProg3_MiniProg4)

- Press the ‘New Prototype’ button to..ation prototype of the selected type.

- Press the ‘Export’ button to export the selected configurations.

[€] Hello_World Debug (KitProg3_MiniProg4) =| - Press the ‘Duplicate’ button to copy the selected configuration.
[€] Hello_World Erase (KitProg3_MiniProg4) ¥ - Press the 'Delete’ button to remove the selected configuration.
[£] Hello_World Program (KitProg3_MiniProg4) > - Press the Tilter button & G - t'

7] GDB PyOCD Debugging ress the ‘Filter' button to configure filtering options.

[] GDB SEGGER J-Link Debugging - Edit or view an existing configuration by selecting it.

@ Launch Group - Select launch configuration(s) and ..otype’ menu item to link a prototype.

- Select launch configuration(s) and ..ype" menu item to unlink a prototype.

- Select launch configuration(s) and t..u item to reset with prototype values.

Configure launch perspective settings from the ‘Perspectives’ preference
page.

Filter matched 9 of 13 items

By D
@ Debug Close

You can open these dialogs from the Run menu or by selecting the down arrow ~ next to the Run and Debug
commands.

These configurations include the application name and protocol, for example:
Hello_World Program (KitProg3_MiniProg4)

Hello_World Debug (JLink) For more information, see Switch to J-Link programmer/debugger.

Note: KitProg3_MiniProg4 configurations may not work if a J-Link probe is attached to the kit.

When an application is created, the tool generates the following launch configurations for both

KitProg3_MiniProg4 and J-Link. Some items display in the Quick Panel, and some are in the Run/Debug
Configurations dialog only.

e Attach: This launch configuration starts a Cortex-M4 debugging session attaching to a running PSoC™ 6
target without programming or reset.

e Debug: This launch configuration builds the entire application on both cores, programs all the device's
memories, and then starts a Cortex-M4 debugging session.

e Erase: This launch configuration erases all internal memories.

e Program: This launch configuration builds the entire application on both cores, programs all the device's
memories, and then runs the program.
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5.1.2 Switch to J-Link programmer/debugger

Most PSoC™-based kits use KitProg3/MiniProg4 as the default programmer/debugger, and they show those
configurations in the Quick Panel:

~ Launches
7&,’; Hello_World Debug (KitProg3_MiniProgd)
Q Hello_World Program (KitProg2_MiniProg4)

5% Generate Launches for Helle_Werld

If you want to use SEGGER J-Link as the programmer/debugger, do the following to change configurations:

1. Open your ModusToolbox™ application's Makefile, and type the following variable:

BSP PROGRAM INTERFACE=JLink

2. Ifyouinstall J-Link software in a non-default location, or if you intend to use make commands, such as
make programandmake gprogram,also enter the following variable:

MTB JLINK DIR=<path to J-Link>

Note: If you want all applications for a BSP to use a given programmer/debugger, you can specify the
BSP PROGRAM INTERFACEand MTB JLINK DIRvariables in the bsp.mk file instead of the
application Makefile.

3. Save the Makefile.
4. Click Generate Launches for <project_name>.

When the IDE refreshes, J-Link configurations will be shown.

« Launches

%’} Hello_World Debug (ILink)

0 Hello_Warld Program (ILink)

Q Generate Launches for Hello_World

5.1.3 Using JTAG interface in MiniProg4

The MiniProg4 can interact with the target via the SWD or JTAG protocol. By default, the SWD protocol will be
used.

In order to use JTAG, you need to add specific commands for the appropriate Debug Configuration. Under the
Debugger tab in the Config options field (after -c "source [find interface/kitprog3.cfg]"), insert the following
lines:

Mame: | Hello_World Debug (KitProg3) |

[E Main | %5 Debugger | = Startup % Source| [[] Common| &, SVD Path
rerpraTh, el

Cenfig options: -5 "/libs/TARGET_CYBCKIT-062-WIFI-ET/COMPOMNEMNT_BSP_DESIGMN_MODUS/Generated5Source” ~

s
-¢ "source [find interfacea'kitproq3.ch]"|

- "puts stderr {Started by GNU MCU Eclipse}”

-c "source [find target/psoch.cfg]" v

Allocate console for OpenOCD Allocate console for the telnet connection

e -c "cmsis dap vid pid 0x04B4 OxF151 0x04B4 OxF152"

e -c "transport select jtag"
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5.1.4 Changing programming interface SWD/JTAG

Usually MCUs support programming/debugging via SWD and JTAG interfaces. The SWD interface is the default,
but you can switch to JTAG, and vice-versa.

Note: There might be a difference in how the MCU functions depending on the selected debugging
interface. All known issues are documented in Release Notes.

5.1.4.1 Single-core projects

Kitprog3/MiniProg4

To change the target interface for KitProg3_MiniProg4, do the following:

1. Open the Debug Configurations dialog and select the required configuration.

2. Switch to the Debugger tab and find the "transport select ..." entry in Config options

3. Setto the value to either 'swd' or 'jtag' as applicable.

Name: | Multicore_Empty_App_XMC7000 Program Application (KitProg3_MiniProg4)

[l Main | % Debugger B Startup| B~ Source| T Commaon| & SVD Path
OpenOCD Setup
Start OpenOCD locally

Executable path: ‘ $lopenocd_path}/${openocd_executable}

Actual executable: ‘ C:/Users/lishchynskyi/ModusToolbox/tools_3.1/openocd/bin/openocd.exe

(to change it use the global or workspace preferences pages or the project propert

GDB port: 3333
Telnet port:
Tcl port: 6666
Config options: -c "source [find interface/kitprog3.cfgl”
-c "transport select swd"
-C pufs s%ﬁerr SERES) [Jy GNU MCU Eclipse}”

Allocate console for OpenOCD Allocate console for t

J-Link

For J-Link, there is a dedicated radio button in the Debug Configurations dialog, under the Debugger tab.
Select the applicable option:

(to change it use the global or workspace preferen

Device name: | ‘

Endianness: @ Little (O Big

Connection: @®UsB OIP u
Interface: E) SWD O JTAG |

Initial speed: O Auto (O Adaptiy @ Fixed | 1000 | kHz

GDB port: 2331
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5.1.4.2 Multi-core projects

There is a special case for multi-core debugging. This is usually launched via the 'Debug MultiCore'
configuration. To switch from one interface to another, the same interface must be set across all involved

configurations. The Debug Configurations dialog shows the list of configurations that are launched as a part of
multi-core debugging.

E Debug Configurations
Create, manage, and run configurations

Launch several other configurations sequentially

FoRX BT~
‘Iyuef ter text

Name: | Dual-CPU_Empty_PSoC6_App Debug MultiCore (KitProg3_MiniProg4)

| & Launches - Common

[€1 GDB Hardware Debugging

Name
g gg: S;SZSCDD bDebuggmg [€] GDB OpenOCD Debugging:Dual-CPU_Empty_PSoC6_App.proj_cm0Op Debug (KitProg3_MiniProg4)
ebugging " . ) .
/] [©] GDB OpenQCD Debugging:Dual-CPU_Empty_PSoC6_App.proj_cm4 Add CM4 to CMO+ (KitProg3_MiniProg4
[£] GDB SEGGER J-Link Debugging P gging _Empty_| _ADD.proj_ [( g3 | g4)

~ @ Launch Group
@ Dual-CPU_Empty_PSoC6_App Debug MultiCore (KitProg3_MiniProg4)
& Multicore_Empty_App_XMC7000 Debug MultiCore (KitProg3_MiniProg4)

5.1.5 Erasing external memory

By default, erasing of external memory is turned off. To erase it, you must modify the "Erase" launch
configuration options on the Debugger tab as follows:

For PSoC™ 64 Secure Boot kits, such as CYS8CKIT-0645052-4343W and CYS8CPROTO-064S51-SB, remove the
following to enable external memory erasing via SMIF:

-c "set DISABLE SMIF 1"

MName: | Hello_World Erase (KitProg3)

[E] Main | %5 Debugger| = Startup % Source| [[] Common | 7, SVD Path
Config options:

-s "${openocd_path}/../scripts”

-c "source [find interface/kitprog3.cfg]”
-c "set TARGET_AP cmd_ap”

c "sct DISABLE SMIF 1]

Allocate console for OpenOCD

Allocate console for the telnet connection

For all other kits, add the path to the GeneratedSource folder (after -s "${openocd path}/../scripts"):

-s "./bsps/<TARGET NAME>/config/GeneratedSource"

MName: ‘ Hello_World Erase (KitProg3)

B Marir? 7‘%& Debugger | b Startup % Source| [C] Common | 2, SVD Path

Config options: -5 "S{openocd_pathl/../scripts”

-5 " /libs/TARGET_CYSCKIT-062-WIFI-BT/COMPONENT_BSP_DESIGN_MODUS/GeneratedSource”|

-¢ "source [find interface/kitprog3.cfg]”
- "source [find target/psoch.cfg]”

Allocate console for OpenQCD Allocate console for the telnet connection

5.1.6 Programming eFuse

PSoC™ 6 MCUs contain electronic fuses (eFuses), which are one-time programmable. They store device specific
information, protection settings and customer data.

By default, eFuses are not programmed even if they are present in the programming file. To enable eFuse

programming, add the following command for the appropriate Debug Configuration, under the Debugger tab
in the Config options field (after -c "source [find target/psoc6.cfgl"):

-c "psoc6 allow efuse program on"

User guide 30 002-24375 Rev. *L

2023-05-16



o _.
Eclipse IDE for ModusToolbox™ user guide In f| neon

Program and debug

Name: | HelloWorld Debug (KitProg3)

5] Main | %5 Debugger| @ Startup | K Source ] Common 2, SVD Path
rerpoh. oo

Config options: | ¢ "source [find interface/kitprog3.cfg]” "
-c "source [find target/psock.cfg]”
PO

Allocate console for OpenOCD Allocate console for the telnet connection

Attention: Since blowing an eFuse is an irreversible process, Infineon recommends programming only in
mass production programming under controlled factory conditions and not prototyping
stages. Programming fuses requires the associated I/0 supply to be at a specific level: the
device VDDIOO (or VDDIO if only one VDDIO is present in the package) supply should be set to
2.5V (+5%).

5.1.7 Debug connection options

By default, a typical PSoC™ 6 application created in the Eclipse IDE includes launch configurations set up for
two probes: Infineon KitProg3 (built into Infineon kits) and Segger J-Link.

Communication Firmware Debug Connection More Information

Infineon-provided KitProg3 OpenOCD via CMSIS-DAP | https://www.infineon.com/cms/en/design-
support/tools/programming-testing/psoc-programming-
solutions/

SEGGER-provided J-Link DLL SEGGER J-Link SEGGER J-Link

5.1.8 Select specific CMSIS-DAP device

If there are two or more CMSIS-DAP devices connected to your computer, the first detected device will be used
by default. KitProg3 supports both CMSIS-DAP modes - HID and BULK. BULK devices are selected first, then HID
devices. You can specify a CMSIS-DAP device by:

e VID and PID of the USB device

e Serial Number of the USB device

e VID, PID, and Serial Number of the USB device

To do this, you must add a specific command for the appropriate Debug Configuration, under the Debugger
tab in the Config options field (after -c "source [find interface/kitprog3.cfg]")

Mame: | BlinkyLED Debug (KitProg3) |

[ Main | % Debugger| = Startup . Source| ] Common | 7, SVD Path
e o brerer

Config options: -5 "$workspace_locl/BlinkyLED_config/GeneratedSource” ~
-c "source [find interface/kitprog3.cfg]”

-c "source [find targeta’psocﬁ.cfg]"‘

-c "gdb_port 3332" v

Allocate console for OpenOCD Allocate console for the telnet connection

5.1.8.1 Selecting by VID and PID

Use OS-specific tools to determine the VID and PID of connected devices. For example, on Windows, use the
Device Manager. Use the "cmsis_dap_vid_pid" command to select a CMSIS-DAP device with a specific VID and
PID. If there are two or more devices with the same specified VID/PID pair, OpenOCD uses the first detected
device from the passed list.

e To specify KitProg3 in CMSIS-DAP BULK mode with VID = 0x04B4 and PID = 0xF155:
cmsis_dap vid pid 0x04B4 O0xF155
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e To specify KitProg3 in CMSIS-DAP HID mode with VID = 0x04B4 and PID = 0xF154:
cmsis_dap vid pid 0x04B4 0xF154

e To specify any (HID or BULK) connected KitProg3 device:
cmsis dap vid pid 0x04B4 O0xF154 0x04B4 OxF155

5.1.8.2 Selecting by serial number

There should not be more than one device with the same serial number. Use this method if you want to use
only one specific device. Use OS-specific tools to determine the Serial Number of connected devices. You can
also use the fw-loader utility with --device-11ist option. See KitProg Firmware Loader.

Use the "cmsis_dap_serial" command to select a CMSIS-DAP device with a specific Serial Number.

e To specify a CMSIS-DAP device with Serial Number = 0BOBOF9701047400 the following command is used:
cmsis_dap serial O0BOB0F9701047400

5.1.8.3 Selecting by both VID/PID and serial number

You can use both commands together in any order. For example:

cmsis dap vid pid 04B4 F155 cmsis dap serial OBOBOF9701047400

5.1.9 Select Specific J-Link Device

If there are two or more J-Link devices connected to your computer, the first detected device is used by default.
You can select a specific J-link device by setting the serial number for the appropriate Debug Configuration,
under the Debugger tab:

Name: | BlinkyLED Debug ()-Link)

[E] Main | %5 Debugger [ Startup & Source [C] Common % SVD Path
B e e T e ] —

kespac
Devicename: | CYBCHa7_CM4_sect256KB |

{to change it use the global or workspace preferences pages or the project properties page)

Endianness: @ Little (O Big

Connection: @ use (®]1] I (USB serial or IP name/address) I
Interface: @ SWD O JTAG

Initial speed: @ Auto O Adaptive () Fixed kHz

5.1.10 KitProg Firmware Loader

The PSoC™ MCU kits include onboard programmer/debug firmware, called KitProg. The CYSCPROTO-062-
4343W kit has KitProg3 by default. However, the CYSCKIT-062-BLE and CY8CKIT-062-WIFI-BT kits come with
KitProg2 firmware installed, which does not work with the ModusToolbox™ software. You must update to
KitProg3. KitProg3 provides the CMSIS-DAP (Bulk) protocol by default, which is up to ~2.5 times faster than the
CMSIS-DAP (HID) protocol. Both modes can be used via OpenOCD.

ModusToolbox™ software includes a command-line tool "fw-loader" to update kits and switch the KitProg
firmware from KitProg2 to KitProg3, and back. The following is the default installation directory of the tool:

<install_path>\ModusToolbox\tools_<version>\fw-loader\bin\

Use the fw-loader tool to update the KitProg firmware as required for your needs. KitProg2 does not work with
the ModusToolbox™ software. Likewise, if you update to KitProg3, PSoC™ Creator won’t work with kits until you
restore KitProg2.
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Note: On a Linux machine, you must run the udev_rules\install_rules.sh script before the first run of the
fw-loader.

For more details, refer to the KitProg3 user guide. The fw-loader tool also provides a readme text file in the fw-
loader installation directory.

5.1.11 Power cycle programming mode with KitProg3_MiniProg4

By default, Launch Configurations use Reset mode to program the device. However, Reset mode is not available
in all situations (for example, if the XRES pin is not available on the part's package). In these cases, Launch
Configurations use an alternative reset using software. However, using the software reset type is not sufficient
in some cases when access to the device's DAP is restricted (such as when set by security settings).

If there is no XRES pin available and DAP access is restricted, the only way to reset a part is to use Power Cycle
mode. Follow these instructions to add commands to the launch configuration and switch to Power Cycle
mode.

1. Open the Launch Configuration to modify.
2. Select the Debugger tab.

3. Inthe Config options field, insert the following lines
(after -c "source [find interface/kitprog3.cfg]"):

Mame: | Empty_PSoC4_App Debug (KitProg3_MiniProg4) |

[E Main %5 Debugger = Startup | % Source| [] Common| &, SVD Path
Config optiens: L -c "source [find interface/kitprog3.cfg]”

- "puts stderr {Started by GNU MCU Eclipse}"
-c "source [find target/psocd.cfg]”
- "psocd.cpu configure -rtos auto -rtos-wipe-on-reset-halt 1"

Lllorate conenle for Onen(TT LAllorate conenle for the telnet cone

For PSoC™ 6:

-c "set ENABLE POWER SUPPLY <mV>"
-c "set ENABLE ACQUIRE 2"

For PSoC™ 4:

-c "set ENABLE_POWER_SUPPLY <mv>"
-c "set PSOC4 USE ACQUIRE 2"

Where, <mv> defines target voltage in millivolts, (for example, use -c "set ENABLE POWER SUPPLY
3300" for3.3V).

Note: Verify the voltage range supported by the target MCU, since it can be damaged by supplying
unsupported voltage. Make sure that your MCU is not powered externally before supplying power
via the KitProg3_MiniProg4.

5.1.12 PSoC™ 4 flash security programming

PSoC™ 4 devices include a flexible flash-protection system that controls access to flash memory. This feature
secures proprietary code, but it can also be used to protect against inadvertent writes to the bootloader
portion of flash. Refer to the device’s Architecture Technical Reference Manual for details.

Flash consists of rows (64/128/256 bytes, depending on the PSoC™ 4 device). Each row of flash can have its
protection level independently set. You can assign one of two protection levels to each row, as shown in the
following table:

User guide 33 002-24375 Rev. *L
2023-05-16


https://www.infineon.com/documentation/development-kitsboards/kitprog-user-guide

o _.
Eclipse IDE for ModusToolbox™ user guide In f| neon

Program and debug

Protection Setting Allowed Not Allowed
Unprotected External read and write, Internal read and write -
Full Protection External read, Internal read External write, Internal write

To apply flash security, include the appropriate data in the application by creating an array of num_rows / 8
size, where num_rows is the actual number of flash rows on the device. Each byte of this array is responsible for
protection of 8 flash rows, and it sets one of two protection levels:

e 0-unprotected

o 1 -full protection

For example, to protect the first 25 rows and the last 5 out of 256 rows, include the following array in your
application:
CY SECTION(".cyflashprotect™)  USED

static const unsigned char flash protect[0x20] =

{
0xFF, OxFF, OxFF, 0x01, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00
}i
To enable flash security, program the device with the updated code. If you wish to reprogram a protected
device, you must first erase it.

5.2 AIROC™ Bluetooth® programming/debugging

AIROC™ Bluetooth® applications have different launch configurations than PSoC™ MCU applications.
Bluetooth® applications use External Tools configurations for programming the device, and Attach
configurations for attaching to the debugger. The Program launch configurations are available from the Quick
Panel when you select <app name> project. Each configuration is preceded by the application name.

~ Audio_20819EVB02
A Build Application
¥ Clean Application

~ Launches

# Audio_20819EVB02 Attach JLink
# Audio_20819EVB02 Attach_KitProg3_MiniProg4
% Audio_20819EVBO2 Program

& Generate Launches for Audio_20819EVB02

+ Tools

5.2.1 Program configuration
This launch configuration runs a script and programs the device's memories.

e <app-name> Program: Program is used to build and program embedded applications onto the target
device.

5.2.2 Attach configurations

The Attach configurations are used to attach to the debugger without first programming the device. They
include:

e <app-name> Attach_JLink
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e <app-name> Attach_KitProg3_MiniProg4

5.2.3 Debug settings

AIROC™ Bluetooth® devices use the JTAG SWD interface on a kit for debug via OpenOCD or J-Link probe.
Typically, GPIOs need to be reprogrammed (via firmware) to enable SWD, so debug can't be performed directly
after a device reset. The debugger is usually attached to a running device and symbols only are loaded.

The CYW920819EVB-02 and CYBT-213043-MESH kits have additional requirements in order to launch the Eclipse
IDE debugger. In general, most debugging for these kits is done with logs and sniffers, since real time execution
is usually needed for the protocols to run properly.

Refer to the AIROC™ Hardware Debugging document for more details.
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